SDLS$

www.sdl.com

SDL Trados Studio 2015 SR2

Trados

SD L Studio 2015

Installation Guide




SECTION 1: SDL TRADOS STUDIO
2015 SR2

Installation Guide




COPYRIGHT

SDL Trados Studio 2015 SR2

Installation Guide
Copyright © 2009—2016 SDL Group

Nothing contained herein may be reproduced, copied,
modified or adapted, without the prior written consent of
SDL Group. SDL Group means SDL PLC. and its
subsidiaries. All intellectual property rights contained
herein are the sole and exclusive rights of SDL Group. All
references to SDL or SDL Group shall mean SDL PLC.
and/or its subsidiaries details of which can be obtained
upon written request.

All rights reserved. Unless explicitly stated otherwise, all
intellectual property rights including those in copyright in
the content of this documentation are owned by or
controlled for these purposes by SDL Group. Except as
otherwise expressly permitted hereunder or in accordance
with copyright legislation, the content of this site, and/or
the documentation may not be copied, reproduced,
republished, downloaded, posted, broadcast or
transmitted in any way without the express written
permission of SDL.

SDL Trados Studio, SDL MultiTerm, SDL MultiTerm
Online, SDL Studio GroupShare, PerfectMatch, SDLX,
Passolo, TranslationZone, SDL Translator's Workbench,
SDL TagEditor, QuickPlace, AutoSuggest, BeGlobal and
GlobalConnect are registered trademarks of SDL Group.
All other trademarks are the property of their respective
owners. The names of other companies and products
mentioned herein may be the trademarks of their
respective owners. Unless stated to the contrary, no
association with any other company or product is
intended or should be inferred. This product may include
open source or similar third-party software, details of
which can be found by clicking the Acknowledgments
section. Although SDL Group takes all reasonable
measures to provide accurate and comprehensive
information about the product, this information is
provided as-is and all warranties, conditions or other
terms concerning the documentation whether express or
implied by statute, common law or otherwise (including
those relating to satisfactory quality and fitness for
purposes) are excluded to the extent permitted by law.

SDL TRADOS STUDIO 2015 SR2 INSTALLATION GUIDE

To the maximum extent permitted by law, SDL Group
shall not be liable in contract, tort (including negligence or
breach of statutory duty) or otherwise for any loss, injury,
claim liability or damage of any kind or arising out of, or in
connection with, the use or performance of the Software
Documentation even if such losses and/or damages were
foreseen, foreseeable or known, for: (a) loss of, damage to
or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e)
loss of anticipated savings, (f) loss of business, (g) loss of
opportunity, (h) loss of goodwill, or (i) any indirect,
special, incidental or consequential loss or damage
howsoever caused. Information in this documentation,
including any URL and other Internet Web site references,
is subject to change without notice. Without limiting the
rights under copyright, no part of this may be reproduced,
stored in or introduced into a retrieval system, or
transmitted in any form or by any means (electronic,
mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of
SDL Group.

Acknowledgments

SDL Trados Studio includes open source or similar third-
party software:
(™  Sharpziplib and Spring.net distributed
under GNU General Public License version
3 with restrictions
(™  Hunspell distributed under GNU Lesser
General Public License version 3
M  "ICU distributed under IBM ICU License
(M  Log4Net, Xalan and Xerces distributed
under Apache License version 2.0
(9 "Wix distributed under Common Public
License version 1.0

(M  SafeNet Licensing Services distributed under
license

This guide ships with SDL Trados Studio 2015 SR2.

March 2016


http://www.gnu.org/licenses/gpl.html
http://www.gnu.org/licenses/gpl.html
http://www.gnu.de/documents/lgpl-3.0.en.html
http://www.apache.org/licenses/LICENSE-2.0
http://www.apache.org/licenses/LICENSE-2.0

TABLE OF CONTENTS

Chapter1

Chapter 2

Introducing SDL Trados Studio 2015 SR2

About this Guide ....... ... ... . . 1-2
Audience forthis Guide .......... ... ... 1-2
Related Documentation ........... ... ..o, 1-3
Introducing SDL Trados Studio 2015 SR2 ... ........ ... ..., 1-4
About SDL Trados Studio2015SR2 . .. ....... ot 1-4
Trial LICeNnSe ..ottt 1-5
Studio Eitions .. ... 1-6
SDL Trados Studio Professional ............................. 1-6
SDL Trados Studio Freelance . ......... ... ... .. . ... .. .. 1-6
SDL Trados Studio Starter and SDL Trados Studio Express ....... 1-7
SDL Trados Studio Workgroup .................. ... ......... 1-9
Upgrade and Compatibility Information .................... ... ... ... .. 1-10
Information For Upgraders ............ ..., 1-10
SDL Trados Studio Project and Package Compatibility ........... 1-1
Translation Memory Compatibility ........................... 1-12
MultiTerm Compatibility ........ ... oo ... 1-13

Installing SDL Trados Studio 2015 SR2

OV VI W . ettt e e e

System Requirements ........ ... ... . ...
Operating Systems . ......... ... .. i
Internet Browser ....... ... ...
Digital Certificate Requirements .............................
Companion Software Required by SDL Trados Studio 2015 SR2 . . ..
Upgrading from an Earlier Version of SDL Trados Studio .........

About the SDL Trados Studio 2015 SR2 Installer .........................
S-Tagger for FrameMaker . ......... ... ... ... oL
S-Tagger for QuickSilver .. ... ... .. ..
OpenExchange Apps ...ttt
Prerequisite Software ....... ... ... i i i i
Installation Location .......... ... .. ... ... i

SDL TRADOS STUDIO 2015 SR2 INSTALLATION GUIDE

1



Installing SDL Trados Studio 2015 SR2 . ...ttt 2-8

Installation Media ........ ... .. .. ... 2-9
Install SDL Trados Studio 2015 SR2 .. ...t 2-10
Before You Start ........ ... i i 2-10
After Installation .......... ... ... 2-14
Logging an Installation .......... ... ... ... ... ..o oL, 2-14
Software Updates ... ........uuuu 2-15
Temporary Directory ......... ... ... i 2-15
Individual User Software Updates ............................ 2-15
Group Policy Software Updates . ..., 2-16
Logging a Software Update ................................. 2-20
Removing your Software Update ........... ... ... ... .. ... 2-20
Maintaining your Installation .................. ... ... .. . o 2-21
Repairing your SDL Trados Studio 2015 SR2 Installation ....... ... 2-21
Removing SDL Trados Studio 2015SR2 . ........... ... ... ... 2-21
Technical Support ... ... 2-22
What's Next? ... 2-23

2 SDLTRADOS STUDIO 2015 SR2 INSTALLATION GUIDE



INTRODUCING SDL TRADOS
STUDIO 2015 SR2

This chapter gives you an overview the of SDL Trados Studio
2015 SR2 client installation procedure and the SDL Trados
Studio 2015 SR2 system. Sections include:

™

™
™
™

About this Guide
Introducing SDL Trados Studio 2015 SR2
Studio Editions

Upgrade and Compatibility Information

Chapter



About this Guide
[

ABOUT THIS GUIDE

This guide describes how to install and license SDL Trados Studio 2015 SR2 client.
This guide does NOT cover:

™M Installing the server components of SDL Trados Studio 2015 SR2

™M Installing the SDL MultiTerm 2015 application

(M  Converting or upgrading existing translation resources to use with SDL Trados Studio 2015
SR2

™M  Using SDL Trados Studio 2015 SR2

Audience for this Guide

This guide is for anyone who is installing any edition of SDL Trados Studio on a personal computer.
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Related Documentation

™

SDL GroupShare Installation Guide - contains information about installing the server
components of SDL Trados Studio 2015 SR2 and how to upgrade server-based translation

memories from SDL Server 2009.

SDL Trados Studio Migration Guide - contains information about converting or upgrading
existing translation resources from SDL Trados 2007 and SDLX so that you can work with
them in SDL Trados Studio 2015 SR2.

SDL Trados Studio Help - contains information about using SDL Trados Studio 2015 SR2.

Translating and Reviewing Documents Quick Start Guide - contains information for

translators and reviewers. It focuses on how to translate and review files.

Project Management Quick Start Guide - contains information for project managers. It

focuses on the project lifecycle.

Translation Memory Management Quick Start Guide - contains information for users who

create and maintain translation memories.

SDL MultiTerm 2015 Desktop Installation Guide - contains information about installing SDL

MultiTerm 2015 Desktop.
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INTRODUCING SDL TRADOS STUDIO 2015 SR2

SDL Trados Studio 2015 SR2 is an integrated environment that enables translation teams to share
translation tools, resources and project files. Resources such as translation memories can be shared
over an intranet or over the Internet.

You can also use SDL Trados Studio 2015 SR2 as a single-user tool where the SDL Trados Studio
2015 SR2 software and translation memories are located on your computer and there is no
interaction with translation memories or projects over an intranet or the Internet. Single users can
open and work with project packages created in other SDL Trados Studio 2015 SR2 installations.

About SDL Trados Studio 2015 SR2

The SDL Trados Studio 2015 SR2 contains tools that enable you to:
Create and maintain local and server-based translation memories.
Create and manage translation projects.

Open documents and translate them.

™
™
™
M  Open server-based and local translation memories and apply them to documents.
™M  Open local and server-based termbases and apply them to documents.

(M  Update translation memories and termbases during translation.

™

Align existing translated documents to generate translation memory content.

In a setup that includes server components, the SDL Trados Studio 2015 SR2 client communicates
with server components through an intranet (through a LAN or WAN) or through the Internet using
SDL GroupShare. SDL GroupShare includes the following components:

M  Project Server
™M TM Server

™M  MultiTerm Server

SDL TRADOS STUDIO 2015 SR2 INSTALLATION GUIDE
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Trial License

SDL Trados Studio 2015 SR2 includes a 30 days trial license. At the end of 30 days, purchase a license
if you want to continue using Studio.
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STUDIO EDITIONS

The following editions of SDL Trados Studio 2015 SR2 are available:
™M  Professional

Freelance

Starter

Express

A L L

Workgroup

SDL Trados Studio Professional

SDL Trados Studio Professional is the complete package that includes all available features. If you
are also working with SDL GroupShare, the server component of Studio, this edition gives you
project manager functionality designed for use in GroupShare environments.

NOTE

If you are translating for a regulated industry, a separate license enables you to create regulator
review bundles. These bundles contain a specific collection of documents needed by the
regulator for review.

Regulated Industries add-on

If you are translating for a regulated industry, you can purchase an additional license that enables
you to create regulator review bundles. These bundles contain a specific collection of documents
needed by the regulator for review. This license is an add-on for a Professional edition of Studio.

Translation Quality Assessment add-on

SDL Trados Studio Professional ships with the TQA add-on by default. This enables you to create
TQA configurations for your projects in order to measure the quality of a translation using custom
quality criteria.

SDL Trados Studio Freelance

SDL Trados Studio Freelance is limited in the following ways:
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™M  You can only work with five languages. To change your language selection at a later point,
return the license, uninstall and reinstall, then activate your license again. This will take you
back to the language selection window.

™M  You can use AutoSuggest dictionaries but you cannot create them. If you want to create
AutoSuggest dictionaries, a separate AutoSuggest license enables you to do this.

™M  You cannot use SDL Trados Studio Freelance on a computer that is part of a domain-based
corporate network.

™  You can open and work with project packages, but you cannot create them.

™M  You can add and edit translation quality assessments, but you cannot create a Translation
Quality Assessment configuration for a project.

™M  You cannot create custom task sequences.
M  You cannot apply PerfectMatch to project files.

™M  You cannot publish GroupShare server-based projects.

SDL Trados Studio Starter and SDL Trados Studio Express

SDL Trados Studio Starter and SDL Trados Studio Express both have similar functionality to
Freelance. What you can do in Starter and Express depends on which workflow you are using. The
following list shows the key tasks that you can perform in each workflow. Express also allows you to
run Studio as part of a domain-based corporate network and have use of an unlimited number of
languages.

What you can do in Starter and Express

Single-File Translation Workflow in Starter

You can perform the following actions when you are in a single-file translation workflow. A single-
file translation workflow occurs when you open a single file for translation using the Translate Single
Document command.

NOTE

This workflow is not available in Express.

M  Open a single file for translation.

™  Create file-based translation memories.
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™

W W O L & W

Add a single file-based translation memory to use during translation. The size of the
translation memory is specified by your license.

Add and remove termbases for translation.

Edit translation units in a translation memory during translation.

Edit translation memory settings.

You can import and export translation memory data to or from a translation memory.
Update the translation memory during translation.

Generate a translated document.

Project Package Translation: Offline Workflow in Starter and Express

You can perform the following actions when you are in a project using packages in an offline

workflow:

™

™
™
™
™
™
™
™

Open project packages. In Express, you can only open packages created in an SDL enterprise
product. Enterprise products include WorldServer and TMS.

Open files for translation or review from a project package.

Disable or enable termbases in the package for translation.

Disable or enable translation memories in the package for translation.
Remove AutoSuggest dictionaries in the project for translation.

Edit translation units in a translation memory during translation.
Update the translation memory during translation.

Return completed work in return packages.

Restrictions in Starter and Express

™

The following batch tasks are disabled in Starter: Translation Quality Asessment, Apply
PerfectMatch, Populate Project Translation Memories, Update from Reviewed Target File
(Retrofit), Pre-translate Files, Update Main Translation Memories, Update Project Translation
Memories.

The following batch tasks are disabled in Express: Translation Quality Asessment, Apply
PerfectMatch, Update from Reviewed Target File (Retrofit).
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(M  The Add Files, Add Folders, Add New Folder and Remove Files commands in the Files view are
disabled in both versions.

™M  You cannot specify custom settings when upgrading translation memories from previous
editions of SDL Trados or SDLX in both versions.

(™ Translation memory maintenance in the Translation Memories view is disabled in both
versions.

[  The Align Single File Pair, Align Multiple Files and Open Alighment commands along with the
Alignment view are disabled in both versions.

SDL Trados Studio Workgroup

If you are working with SDL GroupShare, the server component of Studio, the SDL Trados Studio
Workgroup edition gives you functionality designed for use in GroupShare environments.

™M  You can open GroupShare projects.

™M  You can translate or review documents from GroupShare projects.

Other standard Studio functionality is available with the following limitations:
(M  You cannot create new projects.

™  You cannot publish projects to SDL GroupShare.

™M  You cannot perform TM maintenance in Translation Memories view in Studio.
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UPGRADE AND COMPATIBILITY INFORMATION

Information For Upgraders

If you currently have a previous version of SDL Trados or SDLX installed, you do not need to
uninstall them before installing SDL Trados Studio 2015 SR2. The new version of the software will
be installed side-by-side with previous versions of the software.

However, as a service release for Studio 2015, Studio 2015 SR2 installs on top of previous Studio 2015
versions and cannot run alongside these. Studio keeps all the configurations set in your 2015 version
when you upgrade to Studio 2015 SR2.

If you want to install SDL Trados Studio 2014 and SDL Trados Studio 2015 SR2 on the same
computer, make sure that you install the 2014 version first.
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SDL Trados Studio Project and Package Compatibility

Projects
Projects in the 2011, 2014 and 2015 versions of SDL Trados Studio are of the same format.

Projects created in SDL Trados Studio 2009 SP3 can be upgraded for use in SDL Trados Studio 2015
SR2. When you open a 2009 SP3 project in SDL Trados Studio 2015 SR2, you are asked if you want
the project to be upgraded to the 2015 format. When you upgrade the project, the converted 2015
project is saved in the location of your choice and you can then choose if you want to archive the old
2009 project. If you do not archive the project, it is left in the 2009 project folder and can still be
opened in SDL Trados Studio 2009 SP3.

NOTE

If you still need to work with SDL Trados Studio 2009 SP3 users who have not upgraded to a
2015 version of SDL Trados Studio, you can do this through the use of packages.

Packages

Packages in the 2011, 2014 and 2015 versions of SDL Trados Studio are the same format so you can
easily work in a workflow between the three versions.

SDL Trados Studio 2015 SR2 supports a project package workflow between a 2015 version of SDL
Trados Studio to SDL Trados Studio 2009 SP3 and back. To send packages to a 2009 user from
2015, select Projects view > Home tab > Create Studio 2009 Project Package option. For more
information, see the online Help in SDL Trados Studio.
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Translation Memory Compatibility

Software

SDL Trados Studio 2015 SR2 can connect to any 2011 and 2014 version of SDL TM Server. SDL
Trados Studio 2015 SR2 cannot work with earlier versions of this server.

Server-based Translation Memories

You can use server-based translation memories created in SDLTM Server 2014, SDLTM Server 2011
and SDL TM Server 2009 SP3 directly in SDL Trados Studio 2015 SR2.

To use server-based translation memories created in SDL TM Server 2009 1.0, SP1 or SP2 in Studio
2015 SR2, first convert them to current SDL TM Server version format.

For information on how to upgrade these server-based translation memories, see the SDL
GroupShare Installation Guide.

You can also use server-based translation memories created in SDLX Server, SDL TM Server 2007
or earlier versions of this product in Studio 2015 SR2 if you first convert them to the current format.
To do this, use the Upgrade Translation Memories wizard in SDL Trados Studio. For more
information, see the SDL Trados Studio 2015 Migration Guide.

Local (File-based) Translation Memories

If you have local translation memories from any of the SDL Trados Studio 2009 versions, you can
work with them in SDL Trados Studio 2015 SR2.

You can use local translation memories that were created in SDL Trados 2007, SDLX 2007 or earlier
versions of these products in SDL Trados Studio 2015 SR2 if you first convert them to Studio 2015
format. To do this, use the Upgrade Translation Memories wizard in Studio. For more information,
see the SDL Trados Studio 2015 Migration Guide.
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MultiTerm Compatibility

Software

SDL Trados Studio 2015 SR2 is compatible with any 2011, 2014 and 2015 version of SDL MultiTerm
Desktop. Studio 2015 SR2 can only connect to 2011, 2014 and 2015 versions of SDL MultiTerm
Server. Studio 2015 SR2 cannot work with earlier versions of this server.

NOTE

Depending on which edition of SDL Trados Studio 2015 SR2 you purchased, SDL MultiTerm
2015 may be included in the purchase. However, it is not installed automatically. If you want to
install SDL MultiTerm 2015, you must run the SDL MultiTerm 2015 installer. For more
information, see the SDL MultiTerm 2015 Desktop Installation Guide.

Server-based Termbases

You can use server-based termbases that were created in SDL MultiTerm Server 2015, SDL
MultiTerm Server 2014, SDL MultiTerm Server 2011 or SDL MultiTerm Server 2009 SP3 directly in
SDL Trados Studio 2015 SR2.

Server-based termbases that were created in SDL MultiTerm Server 2007 and 2009 SP1 or SP2 can
be used in SDL Trados Studio 2015 SR2, but they must first be converted to SDL MultiTerm Server
2015 format. To do this, use the SDL MultiTerm Server Upgrade Wizard in the SDL MultiTerm Server
Console. For more information, see the SDL MultiTerm 2015 online Help.

Local (File-based) Termbases

If you have access to termbases from any version of SDL MultiTerm 2015, 2014, 2011 or SDL
MultiTerm 2009 SP3/SP4, you can work with them in SDL Trados Studio 2015 SR2.

You can search termbases, insert term translations into documents, add new terms to termbases and
edit or delete termbase entries.

Local termbases created in MultiTerm 2009, SDL MultiTerm 2007 (7.5 and 7.x releases) or
MultiTerm iX (version 6.x) can also be used in SDL Trados Studio 2015 SR2 but they must first be
converted to SDL MultiTerm 2015 format.

When you select a termbase from a version previous to SDL MultiTerm 2009 SP3/SP4 in SDL
Trados Studio 2015, you are asked if you want the termbase to be converted to SDL MultiTerm 2015
format. When a termbase is converted, the converted termbase file overwrites the original termbase
in the same location.
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NOTE

™ Once a termbase has been converted to SDL MultiTerm 2015 format, it cannot be reverted
to an earlier format.

™ If you want to work with SDL MultiTerm 2009 (1.0, SP1, SP2), SDL
MultiTerm 2007 or MultiTerm iX termbases in SDL Trados Studio 2015
SR2 and you also want to be able to open the termbases in the original
MultiTerm application, create copies of the termbases before you open them
in SDL Trados Studio 2015 SR2.
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INSTALLING SDL TRADOS
STUDIO 2015 SR2

This chapter contains all the information you need to install
SDL Trados Studio 2015 SR2 client. It describes the hardware
and software requirements for running SDL Trados Studio

2015 SR2 and provides a step-by-step guide to installing SDL
Trados Studio 2015 SR2. Sections include:

™

™

A L L O

System Requirements

About the SDL Trados Studio 2015 SR2 Installer
Installing SDL Trados Studio 2015 SR2
Software Updates

Maintaining your Installation

What’s Next?

Chapter
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OVERVIEW

This chapter describes the system requirements and installation steps for Studio 2015 SR2.

SYSTEM REQUIREMENTS

To install and run SDL Trados Studio 2015 SR2 you need:

™M A Microsoft Windows-based PC (including Intel-based Apple Mac computers running
Windows as an operating system) with 1 gigahertz (GHz) or higher, 32-bit (x86) or 64-bit (x64)
processor and 2 GB RAM (32-bit) or 4 GB RAM (64-bit).

[ A screen resolution of 1280x1024 pixels and 256 colors or higher.
™M 2 GB of available disk space to run Studio.
™M  Upto 2.5 GB of available disk space to run the Studio installer.

For optimum performance on 64-bit operating systems, SDL recommends a recent processor with
dual or multi-core technology, 4GB of RAM and a screen resolution higher than 1280x1024.

To successfully license SDL Trados Studio 2015 SR2, it is important that your network adapter is
enabled.

Operating Systems

[  SDL Trados Studio 2015 SR2 runs on the latest build of Windows 10, the latest updated
version of Windows 8.1 and the latest service-packed version of Windows 7.
Studio also supports Windows Server 2008 R2 and Windows Server 2012 R2 to facilitate
certain scenarios, for example where Citrix terminal services are used.

™M  Studio 2015 SR2 has dropped support for Windows 8.
M  Studio 2015 has dropped support for Windows Vista.

M  Studio does not support earlier operating systems such as Windows XP, Windows 2000,
Windows NT, Windows 98 and Windows 2003 Server.

™M  SDL recommends that you use the same operating system as the other users with whom you
are sharing packages as the number of supported languages can vary depending upon the
operating system used.
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Internet Browser

(™  Microsoft Internet Explorer 7 is the minimum requirement for SDL Trados Studio. You need
this for displaying the online Help.

M  Ifyou access the Help directly in a browser instead of clicking the Help button inside the
Studio application, you can also use Mozilla Firefox 3 or higher.

Digital Certificate Requirements

All SDL Trados Studio code and installer files are digitally signed. Make sure your list of approved

root certificates is up-to-date and includes the root certificate from the Certification Authority that

generates SDL's code signing certificate. At the time of writing, Studio require DigiCert Assured 1D
Root CA and DigiCert Assured ID Code Signing CA-1.

M  For computers with access to the Internet, go to https://www.digicert.com and add the new
root certificate to your Trusted Root Certification Authorities certificate store. This is only

available for computers running on operating systems supported by Microsoft (Windows Vista
or later).

™M  For computers in a locked down corporate environment without access to the Internet, follow
the instructions available at https://technet.microsoft.com/library/dn265983.aspx.

You can also download the specific root certificates directly from
https://www.digicert.com/digicert-root-certificates.htm and apply the certificates to each
locked down workstation manually or by group policy.
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Companion Software Required by SDL Trados Studio 2015 SR2

Companion software is the non-SDL software that you may want to have installed on your computer
so that SDL Trados Studio 2015 SR2 can function correctly.

Microsoft Office 2007-2013

SDL Trados Studio 2015 SR2 fully supports all Microsoft Office 2007, 2010 and 2013 file formats.
Microsoft Office 2007, 2010 or 2013 is required to use:

™  the Preview features

™M  Microsoft Word spell-checking

Microsoft Word 2003 or later
This is needed for processing RTF-based files.
The Real-time preview feature is not available for Click-to-Run versions of Word or for Word 2003.

The Microsoft Excel 2000-2003 file filter converts Microsoft Excel 2000-2003 files to Microsoft
Excel 2007 documents on the fly and reconverts them back to Microsoft Excel 2000-2003 after
translation. This speeds up the conversion for Microsoft Excel 2000-2003 documents significantly.
For this file type to work correctly:

™M  On computers with Microsoft Excel 2000-2003 installed, install the Microsoft Office 2007
compatibility pack available from http://www.microsoft.com/downloads. This will ensure that
SDL Trados Studio 2015 SR2 can do the on-the-fly conversion. If the compatibility pack is not
installed, the previous, slower Microsoft Excel 2000-2003 filter will be used.

™M  On computers with Microsoft Excel 2007 installed, you do not need to do anything. The
conversion will happen in the background.

Upgrading from an Earlier Version of SDL Trados Studio

You do not have to uninstall an earlier SDL Trados Studio version before installing SDL Trados
Studio 2015 SR2.

SDL TRADOS STUDIO 2015 SR2 INSTALLATION GUIDE


http://www.microsoft.com/downloads

About the SDL Trados Studio 2015 SR2 Installer Iz‘
|

ABOUT THE SDL TRADOS STUDIO 2015 SR2
INSTALLER

The installer for SDL Trados Studio 2015 SR2 contains the following items:

SDL Trados Studio 2015 This is the SDL Trados Studio 2015 SR2 product.
SR2

These enable you to work with SDL MultiTerm termbases without
having SDL MultiTerm Desktop installed.

SDL MultiTerm 2015
NOTE
settings including SDL

MultiTerm 2015 Core SDL MultiTerm Desktop 2015 is not included in the

SDL Trados Studio 2015 SR2 installer. For more
information, see the SDL MultiTerm 2015 Desktop
Installation Guide.

SDL Trados Legacy This contains S-Tagger for FrameMaker and S-Tagger for
Compatibility Module for QuickSilver. You can launch these applications from File >
Studio 2015 SR2 Legacy DTP Formats.

OpenExchange Abps There are four OpenExchange Apps included in the installation.
P ge app These are add-ons to enhance the existing Studio functionality.

For Studio 2015 SR2 to work, there are a number of other pieces
of software that need to be present on your computer. Most of
these are also used by other applications and you probably have
Prerequisite software Y ) PP youp . /

them already. However, if they are not present, they will be
installed automatically.

A complete list of the prerequisite software is given below.

The WorldServer components contain the essential
WorldServer resources that enable the Studio-WorldServer
integration.

SDL WorldServer
components

S-Tagger for FrameMaker

This is a conversion tool, used to prepare FrameMaker MIF files for translation with SDL
Translator’'s Workbench, SDL TagEditor and Word.
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S-Tagger for QuickSilver

This a conversion tool used to prepare Interleaf IASCII files for translation with SDL Translator’s
Workbench, SDL TagEditor and Word. Interleaf is part of the QuickSilver XML application suite.

OpenExchange Apps
™M SDL Batch Find and Replace.
™M SDLTTIXIT!
™  SDL T-Window for Clipboard.
™ SDL XLIFF Converter for Microsoft Office.
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Prerequisite Software

The SDL Trados Studio 2015 SR2 installer will install the following software, if it is not already
present on your computer:

Microsoft .NET Framework 4.5.2
Windows installer 4.5
Microsoft Visual C++ 2013 Redistributable

™

™

™

™M  Microsoft Visual C++ 2010 Redistributable

(™  Microsoft Visual C++ 2008 Redistributable SP1
™

Microsoft Office 2003 Primary Interop Assemblies (only required if Microsoft Office 2003 is
installed on the computer where SDL Trados Studio is being installed)

™  Microsoft Office 2007 Primary Interop Assemblies (only required if Microsoft Office 2007 is
installed on the computer where SDL Trados Studio is being installed)

M  Microsoft Web Services Enhancements 2.0 SP3

™M  Open XML SDK 2.0 for Microsoft Office

Installation Location

The default installation location for SDL Trados Studio 2015 SR2 components is:
$programfiles (x86) %$\SDL\SDL Trados Studio\Studio4

The Program Files folder on your computer may have a different name if you are using a non-
English operating system.
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INSTALLING SDL TRADOS STUDIO 2015 SR2

Installing SDL Trados Studio 2015 SR2 involves the following steps:

Install SDL Trados Studio 2015 SR2 from your SDL Acccount.
The installer contains a number of compressed files which Studio
decompresses when you start the installation. Next, the actual
installation takes place.

Step 1

Once installed, you can start SDL Trados Studio 2015 SR2. The
Product Activation dialog box is displayed. Here you can activate
your product or choose to use the 30 days trial. The trial license
runs SDL Trados Studio in Professional mode for 30 days. At the
Step 2 end of 30 days you must activate your own license. If you do not
have a valid license at that time, you can no longer use Studio.
If you have purchased a Freelance, Starter or Express license, you
may want to take advantage of the trial license as it will give you
access to more functionality than your own license. For more

information, see Studio Edjtions on page 1-6.
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Installation Media

(™ Ifyou downloaded the software from your SDL Acccount > Products & Plan, go to the location
where you stored the downloaded files and run the installer from there.

M Ifyou are installing the software from a network resource, ask your system administrator for
the network location of the SDL Trados Studio 2015 SR2 installer setup program.
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The installation routine for SDL Trados Studio 2015 SR2 is based on an installation wizard which
guides you through the process.

™M Toinstall SDL Trados Studio 2015 SR2, you must have local administrator rights on your
computer.

™M  The installer also supports administrative and silent installations. You can find instructions
for administrative and silent installations in the Studio Enterprise Deployment Guide which is
available from SDL Customer Support. For information on how to contact Customer Support,
see www.sdl.com/support/language-technology-products.

Before You Start
To install SDL Trados Studio 2015 SR2:

1 In the Downloads area of the SDL Account website, click the Download button next to SDL
Trados Studio 2015 SR2:

.!', Alternative download via FTP

2 Click Run to download the self-extracting installation executable file.

NOTE

If you encounter any problems downloading the file, click the Alternative download via FTP link
to download the file from an FTP side instead.
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When all of the installation files have been decompressed, the first page of the SDL Trados
Studio 2015 SR2 installer is displayed.

T sDL Trados Studio 2015 SR2 == =]

-~

This will install SDL Trados Studio 2015 SR2. Once
€ you hawe activated your license, the application will
& run in the Edition mode matching your activation
code (for instance, Freelance or Professional). You
can always check the current Edition mode in Help
About. If you are installing this product for the first

time, a 30-day trial of the Professional version will be
installed for you automatically.

The contents of this package will be decompressed
and then the installation process will begin.

SDL|EE

[ Mocept | [ Dedine

3 Click Accept. The installer files are extracted to your computer. When all of the installer
files have been extracted, the License Agreement page is displayed.
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NOTE

If you do not have Microsoft .NET Framework 4.5.2 and Windows installer 4.5 installed, these
are installed now and you may be asked to restart your computer.

" £ DL Trados Studio 2015 SR2 elEr=]

License Agreement

“You must read and accept the license agreement to use this product.

SDL

License Terms |i|
SDL Trados Studio

These license terms are an agreement between SDL Global Solutions (Ireland) Limited ("SDL"), and you. They apply to the software
named above which includes all associated media, printed materials, and “online” or electronic documentation. The terms also apply

to any SDL:
* updates
* supplements
« Internet-based services, and
e support services

for this software, unless other terms accompany those items. If so, those terms apply.

By installing copying, or otherwise using the software, you agree to accept these terms. If you do not accept the terms, do
not use the software.

If you use the software the following terms apply (which will bind you and your employees):

4 Inetallatinn and Hlea Dinhte

| accept the terms of the license agreement

| =
H
v
Ié‘
:.&'

License Agreement

4 Accept the license agreement and click Next.
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A screen listing all of the components that will be installed is displayed.

5  The installer installs the components and indicates the progress of the installation.

< SDL Trados Studio 2015 SR2 =N B

Please wait while setup corfigures the following components as required.

Action
':'-E':' Checking conditions
O Installing Suite repair utility
O Installing Microsoft Visual C++ 2008 Redistributable SP1
O Installing Microsoft Visual C++ 2010 Redistributable
O Installing Microsoft Visual C++ 2013 Redistributable
':'-E':' Installing Microsoft Office 2003 Primary Interop Assemblies
':'-E':' Installing Microsoft Office 2007 Primary Interop Assemblies
O Installing Licensing Initialization Liility
O Installing Open XML SDK 2.5 for Microsoft Office
O Installing Microsoft Web Services Enhancements 2.0 SP3
O Instaling SDL WordServer Components
O Installing SDL Trados Legacy Compatibility Module
':E:' Installing SDL Trados Studio 2015 SR2
Deleting older versions of SDL Trados Studio 2015

Please wait. Preparing installation.

Installing SDL Trados Studic 2015 5R2

6  When the installation is complete, a confirmation dialog box is displayed. Click OK.

' SDL Trados Studio 2015 SR2 ==

) Set-up has completed successfully.

SDL Trados Studio 2015 SR2 is now added to the Start menu under Programs > SDL > SDL Trados
Studio 2015.
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After Installation

When you first start Studio, the following windows help you set up Studio for first time use:

1  The Product Activation dialog box, where you can activate Studio or choose to use the 30 days
trial. For more information on licensing Studio, click the Help button on this dialog box or go
to the SDL Licensing online Help.

2 The SDL Trados Studio Setup wizard, where you can:

™ specify your user details and user profile for this instance of Studio.
™ start participating in the SDL Customer Experience Improvement Program.

™ load a sample project in order to explore the Studio functionality at startup.

3  The Welcome to Language Cloud wizard where you can connect SDL Trados Studio
with SDL Language Cloud. This gives you access to SDL smart machine translation
engines from within Studio. Use your SDL Account credentials to sign up to Language
Cloud and activate the 30 days free trial.

Logging an Installation

The installation is logged automatically. Log files are created here:

%ALLUSERSPROFILE%\Application Data\SDL\Chainer\Logs
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Some software updates to the application can be downloaded from within SDL Trados Studio or
software updates can be automatically checked for and downloaded when SDL Trados Studio is
started. You can specify how you want SDL Trados Studio to detect application updates or your
system administrator can specify a group policy for all users.

Temporary Directory
Software updates are downloaded to the following temporary directory:
%temp% \studioqupdates

After the update is installed, you can delete the files from this location.

Individual User Software Updates
An individual user of SDL Trados Studio can do the following:

(™  Specify that they want to check for software updates when SDL Trados Studio starts. They can
do this on the Automatic Updates page of the Options dialog box.

M  Manually check for updates by selecting Help > Check for Updates from the ribbon in SDL
Trados Studio.

NOTE

If either of these options is unavailable, the system administrator has set a group policy that
enables or disables checking for software updates.
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Group Policy Software Updates

SDL Trados Studio includes a feature that notifies users of the availability of software updates and
gives them the option to install the updates on their own computer. The system administrator can
set a group policy that controls the way this feature works. You can choose to:

™M  Enable automatic checking for updates. When you choose this option, an automatic check for
updates is made every time a user starts the application. When an update is available, the user
is prompted to apply the update to their installation.

™M  Enable user control of checking for updates. When you choose this option, the users can
enable automatic checks for updates (these take place whenever the application is started) and
they can also check for updates manually at any time. When an update is available, the user is
prompted to apply the update to their installation.

™M  Disable all checks. This option means that automatic checks for updates will not be performed
and users cannot perform manual checks either. You should choose this option if you want to
control the application of updates centrally.

You define a group policy by configuring the Studio4AutoUpdate . adm file in the Group Policy
dialog box.

To define a group policy (note that the screenshots here may vary slightly, depending on the
operating system that you are using):

1 Locate the ADM file. The file name is: Studio4AutoUpdate.adm

The default location for this file is:
$ALLUSERSPROFILE%\Package Cache\SDL\SDLTradosStudio2015

2 Select Start > Run and enter the following command:
gpedit.msc
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The Group Policy dialog box is displayed. Right-click on Computer Configuration >
Administrative Templates and select Add/Remove Templates from the shortcut menu.

File Action View Help

o= x@ =z BE ¥

Software Updates Iz‘
|

= Local Computer Policy
4 8 Computer Configuration
5[] Software Settings
> (] Windows Settings
4[] Administrative Temnlate:

~ Administrative Templates

Select an item to view its description.

> (7] Windows Setti

» ] Administrativ Epmilse

Help

» [1] Control Pa Add/Remove Templates...

» [ Network Fitter On
2 Printers Filter Options...
» [ System )
> B Windows Re-Apply Filter
[ AnSetting:  ay Tasks
4 i, User Configuratio
» (7] Software Settir  View

Setting
[ Control Panel

[ Network

[ Printers

[ System

[ Windows Companents
[ Al Settings

State

.

Exdtended / Standard /

Filter On

The Add/Remove Templates dialog box is displayed. Click Add and browse to the location of

the Studio4AutoUpdate.adm file.

-
Add/Remove Templates

Curment Policy Templates:

Name

Size

Modified

Click Close when the template is added.
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6  Computer Configuration > Administrative Templates > Classic Administrative Templates
(ADM) > SDL Applications > SDL Trados Studio v4 is added to the navigation tree. Select SDL
Trados Studio to display its settings on the right.

7  Double-click on the Enable Autoupdate setting.
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The Enable Autoupdate dialog box is displayed. Select one of the following options and click
OK to save the group policy:

™M Not Configured - The user can choose to enable or disable checking for application updates
automatically when the application starts and can also manually check for application
updates.

™ Enabled - SDL Trados Studio checks for updates automatically when the application starts.
The user cannot disable the automatic updates option. The user can also manually check
for application updates.

™M Disabled - Automatic checks for application updates and manual checks for updates are
disabled. The user cannot enable either of these options.

[E] Enable Autoupdate

@ Mot Configured Comment: -
() Enabled
(©) Disabled -
Supported on: i
Options: Help:
When enabled, the application will check for updates <
automatically. The user may still cancel the update if one is
available.

When disabled, the application will not check for updates, neither
automatically nor from the Help menu.

When this policy is applied, the user's preference in the
application is overriden and cannot be changed in the interface.
When the policy is not configured, the user can check for updates
from the Help menu and they can set whether or not updates are
automatically checked for in the application's settings.
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Logging a Software Update

The update is logged automatically. There are two log files that are created. The firstlog file is created
when checking for updates and downloading installer for the update. This log file is located here:

%ProgramData%\SDL\SDL Trados Studio\Studio4\Updates
The other log file is created during the installation of the update and is located here:

%temp% \studioqupdates

Removing your Software Update
If you encounter any problems after updating your software, you can remove the update.
To remove your software update:
1  From the Start menu on your computer, choose Settings > Control Panel.
2 In the Control Panel, select Add or Remove Programs or Programs and Features.
3 Ensure that the Show updates option is selected.
4 Select the software update from the list of programs and click Remove.

5  Follow the on-screen instructions to remove the software update.

NOTE

In addition to removing the update, clear the Automatically check for updates when the
application starts check box on the Automatic Updates page of the Options dialog box. This
disables the option and prevents the installation of the update again.
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MAINTAINING YOUR INSTALLATION

You can repair or remove your SDL Trados Studio 2015 SR2 installation at any time.

Repairing your SDL Trados Studio 2015 SR2 Installation
Use the repair feature to repair or restore missing files or registry entries in your installation.
To repair your installation:
1  From the Start menu on your computer, select Control Panel.
2 In the Control Panel, select Programs> Uninstall a Program.

3 Select SDL Trados Studio 2015 SR2 from the list of programs and click Repair. This starts the
Windows Installer which runs the repair process.

4  When the process is complete, click Finish.

5  Repeat for MT Core and Trados Studio Compatibility if applicable.

Removing SDL Trados Studio 2015 SR2

Before uninstalling, we recommend that you deactivate your product license. To do this, call up Help
> Product Activation in the application.

To uninstall:
1  From the Start menu on your computer, choose Control Panel.
2 In the Control Panel, select Uninstall a Program.
3 Select:
[ SDL Trados Studio 2015 SR2 - Remove suite of products from the list of programs to
remove SDL Trados Studio 2015 SR2 and all of the components installed with the

application. See About the SDL Trados Studio zo15 SRz Installer on pages-5for a list of the
components installed with SDL Trados Studio 2015 SR2.

™M SDL Trados Studio 2015 SR2 from the list of programs to remove only the SDL Trados
Studio 2015 SR2 application.

4  Choose Remove or Uninstall as appropriate.
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Technical Support

For more information on technical support, consult the online Support Center at
http://www.sdl.com/support/
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WHAT'S NEXT?

The instructions in the SDL Trados Studio Video Help Series and the Quick Start Guides will quickly
get you started with SDL Trados Studio. You can access the guides and videos directly from the SDL
Trados Studio Help.

If you have some existing translation resources, translation memories for example, you should
migrate them to the SDL Trados Studio 2015 SR2 format. Converting or upgrading existing
translation resources so that you can work with them in SDL Trados Studio 2015 SR2 is described in
the SDL Trados Studio 2015 SR2 Migration Guide.
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Learn more at SDL.com.
Follow SDL on Facebook and Twitter.

SDL (LSE: SDL) is the leader in global customer experience. With a completely integrated cloud
solution for content management, analytics, language and documentation, SDL solves the
complexity of managing your brand'’s digital footprint as it grows across multiple languages,
cultures, websites, devices and channels. Seventy-nine of the top 100 global companies trust
SDL to help them create authentic, in-context customer experiences that drive demand and
loyalty. SDL brings your brand to the world, and the world to your brand.
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